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Trademarks

Microsoft is a U.S. registered trademark of Microsoft Corporation.

Windows, Windows Vista, Windows 7, Windows 8, and Windows
10 are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

Energy Star® is a registered trademark of the U.S. government.

IBM, IBM PC are registered trademarks of International Business
Machines Corp.

Other brands and product names herein are trademarks or
registered trademarks of their respective holders.

Copyright

All rights reserved. No part of this publication may be
reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language or computer language, in
any form or by any means, electronic, mechanical, magnetic,
optical, chemical, manual, or otherwise, without the prior written
permission of Avision Inc.

Material scanned by this product may be protected by
governmental laws and other regulations, such as copyright
laws, the customer is solely responsible for complying with all
such laws and regulations.

Warranty

The information contained in this document is subject to
change without notice.

Avision makes no warranty of any kind with regard to this
material, including, but not limited to, the implied warranties
of fitness for a particular purpose.

Avision shall not be liable for errors contained herein or for
incidental or consequential damages in connection with the
furnishing, performance, or use of this material.
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Federal Communications Commission (FCC) compliance
information statement
Part 15

This equipment has been tested and found to comply with the
limits for a Class B digital device, pursuant to Part 15 of the FCC
Rules. These Ilimits are designed to provide reasonable
protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate
radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful
interference to radio communications.

However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one of the
following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and
receiver.

e Connect the equipment into an outlet on a circuit
different from that to which the receiver is connected.

e Consult the dealer or an experienced radio/TV technician
for help.

This device complies with Part 15 of the FCC Rules. Operation is
subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause
undesired operation.
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European Union Regulatory Notice

Products bearing the CE marking comply with the following EU
Directives:

® Low Voltage Directive 2014/35/EC

® EMC Directive 2014/30/EC

® Restriction of the use of certain hazardous substances (RoHS)
Directive 2011/65/EU

CE compliance of this product is valid if powered with the correct
CE-marked AC adapter provide by Avision.

This product satisfies the Class B limits of EN55022, EN55024,
safety requirements of EN 60950 and ROHS requirements of
EN50581.

*This machine is certified as Class 1 LED product.
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Disposal of Waste Equipment by Users in Private Union
]

This symbol on the product or on its packaging indicates that the
product can not be disposed of with your other household waste.
Instead it should be sent to appropriate facilities for recovery
and recycling in an effort to protect human health and the
environment. Fore more information about where you can drop
off your waste equipment for recycling, please contact your local
city office, your household waste disposal service or the shop
where you purchased the product.

As an ENERGY STAR® Partner, Avision Inc. has
determined that this product meets the ENERGY
ENERGY STAR STAR guidelines for energy efficiency.

D
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System Requirements

CPU: Intel® Core™ 2 Duo or higher

Memory: 32 bit: 1 GB
64 bit: 2 GB

Optical Drive: DVD-ROM Drive
USB Port: USB port 2.0 (compatible with USB 3.0)

Compatible Microsoft Windows 10 (32 bits/64 bits),
Operating Windows 8 (32 bits/64 bits), Windows 7,
System: Windows Vista, Windows XP (SP3)

Vi
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Product Safety Guide
Please clearly read all these instructions, and follow all instructions
and warnings before installing and using the device.

The following indications are used in this document to obviate any
chance of accident or damage to you and/or the device.

/N WARNING Indicates potentially hazardous situations, which

if instructions are not followed, could result in
death or serious injury.

/\ CAUTION Indicates a potentially hazardous situation

which, if instructions are not followed, may
result in minor or moderate injury or damage to

property.

/N WARNING

Use only the USB cable that came with your device and avoid
abrasions, cuts, fraying, crimping, and kinking. Using any other
USB cable could cause fire, electrical shock, or injury.
Place the device close enough to the computer so that the
interface cable can easily reach between the device and the
computer.
Do not place or store the device:

e Outdoors

e Near excessive dirt or dust, water, or heat sources

e In locations subject to shocks, vibrations, high
temperature or humidity, direct sunlight, strong light
sources, or rapid changes in temperature or humidity

Do not use the device with wet hands.

Never disassemble, modify, or attempt to repair the device or
device option by yourself, except as specifically explained in
the device's documentation. This could cause fire, electrical
shock, or injury.

vii
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B Unplug the device and the USB cable, and refer servicing to
qualified service personnel under the following conditions:
e Liquid has entered the device.
e Object has entered the device.

e The device has been dropped, or the case has been
damaged.

e The device does not operate normally (i.e. appearance of
smoke, strange smell, odd noise, etc.), or exhibits a
distinct change in performance.

| Unplug the device and the USB cable before cleaning.

/N CAUTION:

B Do not locate the device on rackety or aslope tables. Do not
locate the device on unstable surface. The device may fall
down and this may result in injury.

B Do not place heavy objects on the unit. It may cause unbalance
and the device may fall down. This may result in injury.

[ Store the AC Power cord/USB cable bundled out of the reach of
children to avoid the risk of injury.

B Keep plastic bags bundled out of the reach of children or throw
them away to avoid the danger of suffocation.

[ | If you are not going to use the device for a long period, unplug
the USB cable from the electrical outlet.

Viii
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1. Installing the Scanner

1.1 Preinstallation Information

. Keep the scanner out of direct sunlight. Direct exposure to
the sun or excessive heat may cause damage to the unit.

. Do not install the scanner in a humid or dusty place.

. Place the scanner securely on an even, flat surface. Tilted

or uneven surfaces may cause mechanical problems.

1.2 Checking the Package Contents

Gently open your box and check the package contents. If there
is anything missing or damaged, please call your dealer.

3

1. Scanner main unit
2. Micro USB cable
3. Software CD/Quick guide

Note:

1. Please keep all the packing material in case you may have
to return the scanner for repair.

2. To access more service supports, visit www.avision.com to
register your Avision’s product.

1-1
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1.3 The Rear View

- o

‘ F & °@Ds —  Lock Switch
= I
USB Port / Kensington
Security Slot

Part Name Function
USB Port Connect to your computer.
Lock Switch Protect the scanner from being
damage during transportation.
Kensington Attach to a lock to secure the
Security Slot scanner.

1-2
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1.4 Unlocking Your Scanner

To protect the scanning unit from damage during transportation,
a lock switch is designed at the back of the scanner to keep the
scanning unit from moving. To unlock the scanner, move the
lock switch down as shown in below.

Scanning unit at
this position
before locking the
scanner

Note: If the scanning unit is not located at the front of the

scanner before transporting the scanner, be sure to do the

follows:

1. Turn on the scanner. The scanning unit should move to the
front of the scanner.

2. Press the lock switch down to the “Lock position”.

3. The scanner is now ready to transport.

1-3
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1.5 Installation

NOTE:

1. To ensure your computer can identify the USB scanner,
please install scanner driver first before connecting the
scanner to your computer.

2. The scanner driver contains TWAIN driver. After the
installation of scanner driver is completed, this scanner
allows you to scan via a TWAIN user interface. Start your
TWAIN-compatible image editing software application to
select a TWAIN.

1. Place the supplied CD-ROM onto your CD-ROM drive.
2. The software installation graphic appears. If not, run
“setup.exe”.

AViSiOI'I )S www.avision.com

A vision of your office

Install Scanner Driver

Install A¥Scan X

View Manuals

1-4
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Contents on the installation graphic:

. Install Scanner Driver: To communicate with your
scanner, you need to install the scanner driver.

. Install AVScan X: To scan and organize your
multi-page document(s), you can install the software
application to manage them easily and effectively.

. View Manual: Click “View Manual” to view or
print the detailed user manual for the scanner.

* Download Adobe Reader: To view the user’s
manuals for the scanner, you need to use Adobe
Reader to open and view the manuals in pdf file
format. If you already have Adobe Reader installed
on your computer, you may disregard this item.

3. Click Install Scanner Driver to install the scanner driver
on your computer.

1-5
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1.6 Connecting to Computer

1. Connect the square end of the USB cable to the USB port of
your scanner. Connect the rectangle end to the USB port at
the rear side of your computer.

2. The computer should detect a new USB device and prompt a
“New Hardware Found” message.

3. By following the on-screen instructions, click the Next button
to continue. When the certification screen appears, click
Continue Anyway to complete the installation.

4. When the Finish dialog is prompted, click the Finish button.

1-6


https://manualsfile.com

User’s Manual

2. Completing Your First Scan

2.1 Placing Your Original

1. Open document cover.

2. Place your document with your text FACE DOWN on the
glass.

3. Make sure the upper left corner of your original near the

home position as marked in the scanner.

Document Cover
Home Position
Document

Pl A A

Glass

2-1
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2.2 Veriftying Your Scanner Installation

To verify if your scanner installation is correct, Avision provides
you a useful test program called Avision Capture Tool. With this
tool, you can perform simple scans and view the captured
images. In addition, it helps you complete your scan at a rated
speed.

The following procedure describes how to verify your scanner
installation. If the installation is not correct, please review the
preceding section to check if the cable connection and scanner
driver have been successfully installed.

Before you begin, be sure the scanner is on.

1. Select Start>Programs=>Avision xxx Scanner=Avision
Capture Tool. The Select Scanner Model dialog box will be
displayed.

Select Scanner Model X

Diiver Type
il

Scanner Model
AWISI0N X0 ~

e Cancel

2. Select your driver type and scanner model and click OK.
The following Avision Capture Tool dialog box will be
displayed.

2-2
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Fit Actual
Page Size

@ Avision Capture Tool (TWAIN) - xxxx
File View About

@Semp ] | lcay Seenimege EE [J

Save  File Format File Path

Setup Scan

Choose your desired file format from the File Format drop
down list box. (Default is JPEG, other choice includes TIFF,
MTIFF, PDF, MPDF, GIF, and BMP.) The supported file
formats vary depending on your scanner model.

Type your desired folder name and file name in the File Path
box. (Default is C:\Documents and Settings\User Name\My
Documents\My Scan\lmage.)

Note: If you do not wish to save the scanned image,
deselect the Save button since default is Save Enable. In this
case, the thumbnail view will be disabled. And therefore,
after viewing all the scanned images, only the last one will
remain on the screen.

!n/’.i_ e
Click the Setup button ( f»f‘J tLllJ) or choose Setup from the
File menu to prompt the Scanner Properties dialog box.

2-3
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10.

b Scanner Properties @
image | Pager | Setting | infomaton

Front fute Calor Detection Hnanrat Dynamic Threshokd

Frant Cobor Seriatret: .

Front Gray

Image —
Frond BAW
Selection
BOX Hear Auto Coker Delecton Reschution o) 20
Rsar Color
v ack on White
Rsar Grany
Hoor BAW
Sama setings for both sides
Sean Joute. | Ao Documend Fesder
Profies. Cumbom
Dl ault; 0K Cancel

From the Image Selection Box, choose your desired image
type for your scanned image. (Default is Front B&W) If
you have a duplex scanner, choose Front and Rear to scan
both sides of your document.

Click OK to quit the Scanner Properties dialog box. (To
learn more details about the Scanner Properties dialog box,
please see the subsequent chapter, Using the Scanner
Properties Dialog Box.)

Place your document face down on the document glass or
face up in the auto document feeder.

In the Scan Validation dialog box, click the Scan button

Scan
( o ) or choose Scan from the File menu.

The document will be scanned and displayed in the Scan
Validation screen. After the scanned images have been
displayed, your scanner installation verification is completed.

2-4
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Fit Page View

Thumbnail View

11. You can view the scanned image in Fit Page (‘QL or Actual

Size (100%) button (D ) from the Viewing toolbars at the
right side.

12. Click the Close box or Quit from the File menu to exit the
Scan Validation Tool.
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2.3 A Glance of the Scanner Properties Dialog Box
4 Seanner Properties ==
1 bnage | Pager | Seting | Infomason
Frent /uts Color Desnction HBnansation: Cimiariec Theeshokd =
2T oem 3
o Coor ved. ack on White 5
[Floer B3 6
e e 7
8 = Defauts 0K Concel
1. Tab Options |Choice: Image, Compression, Color Dropout,
Paper, Multi-Feed Detection, Preview, Options,
Settings, Information.
2. Image Choose your image type and the side of

Selection Box

document you wish to scan. Options vary
based on type of scanner.

3. Brightness Adjust the brightness level from —100 to +100.

4. Contrast Adjust the contrast level from —100 to +100.

- Determine the quality of the scanned image.

5. Resolution The industry star?dardyis 200 dpi. ?

6. Invert Reverse the color of your scanned image.

7. Scan Source |Choice: Auto Document Feeder, Flatbed,
Flatbed (Book), Automatic (varies due to
different scanner model)

8. Defaults Reset all values on the tabs to the factory

default settings.

2-6
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3. Using the Scanner
Properties Dialog Box

The Scanner Properties dialog box allows you to configure the
scanner’s settings. It consists of several tabbed windows each of
which will be described in this chapter.

Note: In this chapter, all options are available based on a
duplex (double-side) scanner. If you have purchased a simplex

(single-side) scanner, all options are available for single sided
only.

2> Scanner Properties \El

[imege. [Faper | Seting | formatin]

[F] [Front Auto Color Detection. | | Binarization: [Dyamic Threshold ~~~ ~|

] @ Senstivity: 2 4 (] ¢
O

il T ) '

[T [Rear Auto Calor Detection Resolution (dpi): 200 i [:]

[ [Rear Color
Invert Black on Vilite |
[ |RearGray

[7] [RearBaw

[ Same settings for both sides

Scan Source: [Ma Document Feeder 'I

Profies... | [Custom -

Defauls ok

The Scanner Properties dialog box

3-1
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3.1 Buttons on the Scanner Properties Dialog Box

-2+ Scanner Properties [E3e]

Image | Paper | Setting | Infomation |

[ |Front Auto Color Detection Binanization Dynamic Threshold v]

[71 [Front Color Senstivity: 20 4 = 3

[ [Front Gray

[¥] ||Front B&W

I

-

| [Rear Auta Calor Detection Resolution {dpi): [ZDD ‘]E]

| |Rear Color

=

l

Invert [Black on White ']

7| |Rear Gray

=

| |Rear B&W

[ Same settings for both sides

Scan Source: [Autn Document Feeder 'I

Profies.. | [Custom -

Delaults oK

The buttons on the Scanner Properties dialog box

Buttons | Description

Defaults | Click the Defaults button, the factory default
settings will be shown on each tab.

Cancel Click the Cancel button to leave the Scanner
Properties dialog box.

3-2
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The following table shows the default settings :

Tab name

Default settings

Image

Image : Front B&W

Binarization : Dynamic Threshold
Resolution : 200 dpi

Invert : Blank on White

Scan Source : Auto Document Feeder
Threshold : None

Brightness : None

Contrast : None

Compression

None

Color Dropout

None

Paper

Cropping : Automatic
Deskew : Yes
Orientation : Portrait
OverScan : 0.00

Note: The availability of this option

varies due to scanner model.

Unit : Inch
Multi-Feed None
Detection
Preview None
Options Rotation Degrees : None
Blank Page Removal : None
Edge Fill : White > O mm
Image Control Option : None
Setting Enable Energy Saver : Enable, 15
minutes after last scan action
Show Scanning Progress : Yes
Show Warning Message : Yes
Save Settings after Closing : Yes
Imprinter Digital Imprinter

3-3
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3.2

Showing or Hiding Tabs

The [Scanner Properties] dialog box is displayed in default
with three basic tabs - Image, Paper, and Information. To show
more tabs, click the [Scanner Properties] icon to access more
scan settings.

To show more tabs,

1.

Click the [Scanner Properties] icon ) on the upper

left corner, and choose [Tab] to show available tab names.
The available tabs include Compression, Color Drop out,
Preview, Rotation, Separation, Multi-Feed, Options, Settings,
and Imprinter. (Note: the options vary based on scanner
model.)

Choose the tab you want to display. The selected tab will be
shown with a check mark and then displayed in the
[Scanner Properties] dialog box.

To access the settings, click the selected tab on the top of
the [Scanner Properties] dialog box. The page of the
selected tab will be displayed.

To hide a tab window,

1.

Click the [Scanner Properties] icon () on the upper
left corner, and choose [Tabs] to show available tab
names.

Choose the tab you want to hide. Then, the selected tab
will be hided in the [Scanner Properties] dialog box.

Note: The [Image], [Paper], and [Information] tab can
not be hided since they preprogrammed to be displayed by
default.

3-4
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Scanner Properties =
Tabs 3 Compression
e Color Dropout
x  Close Alt+F4 Multi-Feed Detection Earﬂic Threshold =
rort Calor Feopcw B = '
Rotation

[ [Front Gray —
Separation 04 §
[Frort B Enhancement -

v | Setting

[T [Rear Auto Color Detec] Impanice - :]
o

Invert [Biack on White -
.
&}
[ Same settings for both sides
Sean Source: [Mo Document Feeder V]
Profies .| [Custom -]
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3.3 The Image Tab

The Image tab allows you to choose the front side and (or) the
rear side of your document, the type of image, and to set
several basic scan settings. Note that except for the resolution,
you can set individual scan settings for the front side and the
rear side. For example, all settings in the Image tab,
Compression tab, Color Dropout tab can be set individually for
the front and the rear side. However, the settings in the Paper
tab, the Option tab, and the Setting tab have to be set the same
for the front and rear side.

52 Scanner Properties

Image | Paper | Setting | Information |

[ (From Ao Color Detection | | Binarization (Dynaric Threshold -

[T FrontColor | Senstivty: 24 ‘ ’
O frontGmy ]
o [fomman ]

[ [Rear Auto Color Detection. | Resaluion (dpi): (2 -]
O RearCaer ]
O Rermy ]
O RearBaw ]

[ Same settings for both sides

Invert [Black on White ']

Scan Source: IMO Document Feeder 'I

Profies.. | [Custom -

Defauls i3

The Image tab dialog box
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3.3.1 The Image Selection Box

1ont Auto Color Detection

E 0O

O

iont Colos

‘1ot Gray

Oo

Tont BEW

Rear Auto Color Detection
ear Colos

q]

ear Gray

ear Bt

00

The Image Selection box includes the
image type and document side option. If
you wish to scan both the front side and
the rear side of your color document, you
can check both Front Color and Rear Color

at the same time.
based on type of scanner.

Note the options vary

Example 1 : Scanning a two-sided color document, both

sides in color

[ |Front Auto Colos Detection
=
O
[ [Front B&w

O o Ao Gaobotoion )
o —
T —

Side/Image
Selection

Rear

3-7
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Example 2 - Scanning a two-sided color document, one in

B&W, the other in color

[ |Front Auto Color Detection
o
o

0 s Ao Gaoteaion )
T —
| —

Side/Image
Selection

Front

Image Type

Description

Color

Choose Color if you wish to scan a color
image for your original in color.

Gray

Choose Gray image if your original contains
actual shades of gray.

B&W

Choose B&W if your original contains only
text, pencil or ink sketch.

B&W

3-8
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Front/Rear Auto Color Detection:

Click to automatically detect and scan the front or the rear page
of your color document in color image mode. If your document
is in colors, the scanner will automatically scan the document
into a color image. If your document is non-color, you can
choose the output to be either B&W or Gray from the Non-Color
Selection option. This option is useful when you have a mixture
of color and non-color document.

Note: If you choose Front Rear Auto Color Detection, you can
not specify the image mode of your rear page and vice versas.

Modes of Auto Color Detection:

If [Front/Rear Auto Color Detection] is selected, its modes
will be displayed. Choice includes Normal, Ignore Paper
Color. For paper with background color such as invoices,
choosing [Ignore Paper Color] will automatically remove the
background color and enhance the detection accuracy.

INVOICE INVOICE
e B 3y w3 i Bu day 0 00T
IVIICE 0l 3 foe ars i fon i o EVOICE Sl it

- ot s e of Mo AT Mt schaing e, Lk
14 i i, WML U5 A 240900 499 s 100 B DAL AR 0 e, o, W MO UEA B 103 A5 4 ek 120 O3NS A4
e B W - Besi Wy
Bigged by HT Tmdaaiegin be [T
Bllgens bt A HE T T RAE T

| o b

Normal Ignore single background
color
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Sensitivity of Auto Color Detection

If your documents contain primarily B&W text and small amount
of light or pale colors and you do not wish them to be recognized
as color image to save the file size, you can increase the
sensitivity value by moving the bar to the right to let these
images to be detected as B&W. The value ranges from 1 to 100.
The default is 37.

Standard IEEE 802.11 b/g/n standards compliant

Wireless LAN 1T1R Mode

Frequency Range | 2.400 ~ 2.4835GHz ( subject to local regulations)

802.11n: 20MHz/40MHz

UsA,  Canada  (FCO):11 channels

Number of (2.412GH2~2.462GHz)

Selectable 021

Channels 1bjg: | EUTOPe (CE): 13 chamels (2.412GHz~2.472GH2)
Japan (TELEC): 14 channels
(2.412GHz~2.4835GHz)

r 802.11n: up to 150Mbps
Data Rate 802.11b: 1, 2, 5,5, 11Mbps
802.11: 6, 9, 12, 18, 24, 36, 48, 54Mbps

11n HT40 MCS7 : +13 dBm

Transmit
119 OFDM: +15 dBm
Power(EIRP)
11b CCK: +18 dBm
Security WEP 64/128, TKIP, WPA, WPA2 mixed,802.1x and 802.111

Original

Standard 1EEE 802.11 b/g/n standards compliant Standard 1EEE 802.11 b/g/n stendards compliant
Wireless LAN ITIR Mode Wireless LAN 1TIR Mode
Frequency Range | 2.400 ~ 2.4835GHz ( subject to local regulations) Frequency Range | 2.400 ~ 2.4835GHz ( subject to local regulations)
[ s02:11n: 20MHzz40MHz 802.11n: 20MHZ/40MHz
USA,  Canada  (FCC):11  channels UsA, Canada  (FCO)11  chamnels
Number of (2.412GHz2.462GHz) Number of (2.412GHz~2.462GHz)
Selectable 802.1 Selectable 802.1
Channels 1o7g: | E970Pe (CB): 13 channels (2.4126H2~2.4726t2) Channele Lbjg: | EUTOPe (CE): 13 channels (2.412GHz2.472GHz)
: g
Japan (TELEC): 14 channels 3apan (TELEC): 14 channels
(2.412GHz~2.4835GHz) (2.412GHz~2.4835GHz)
802.110: up to 150Mbps 802.11n: up to 150Mbps
Data Rate 802.11b: 1,2, 5,5, 11Mbps Data Rate 802.11b: 1, 2, 5,5, 11Mbps
802.11g: 6, 9, 12, 18, 24, 36, 48, S4Mbps 802.11: 6,9, 12, 18, 24, 36, 48, 54Mbps
110 HT40 MCS7 : +13 dBm ] 11n HT40 MCS7 : +13 dBm
Transmit Transmit
119 OFDM: +15 dBm 11g OFDM: +15 dBm
Power(EIRP) Power(EIRP) N
11b CCK: +18 dBm 11b CCK: +18 dBm
Security WEP 64/128, TKIP, WPA, WPA2 mixed,802.1x and 802.11i Security WEP 64/128, TKIP, WPA, WPA2 mixed,802.1x and 802.11i

Sensitivity: 1 Sensitivity: 100
(The image is recognized | (The image is recognized
as a color one) as a black and white one)
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Same settings on both sides:

Click to apply same scan settings for both sides of your
documents. After checking this option, any settings you have
changed will automatically applied to both the front side and the
rear side. For example, if you choose your ideal resolution to be
300 dpi, this will be applied both to the front side and rear side
of your document.
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3.3.2 Other Image Options

Binarization This is the process of converting a
grayscale or color image to a bi-tonal
image. There are several different
methods of performing this conversion.
Options: Dynamic Threshold,
Dynamic Threshold (AD), Fixed
Processing, Halftone 1-5, Error
Diffusion.

Dynamic Threshold: Selecting
Dynamic Threshold allows the scanner
to dynamically evaluate each document
to determine the optimal threshold value
to produce the highest quality image.
This is used to scan mixed document
containing faint text, shaded background,
or color background with a single setting.
If Dynamic Threshold is selected,
Threshold, Brightness, and Contrast are
not available.

Dynamic Threshold (AD): Selecting
Dynamic Threshold (AD) to perform
the enhanced mode of the Dynamic
Threshold feature. However, using this
mode may slow down your scanning
speed.
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Sensitivity of Dynamic Threshold
Occasionally your scanned image may
contain small dots or speckles. To remove
these spots, increase the sensitivity value
by moving the bar to the right. The value
ranges from 1 to 30. The default is 20.

Fixed Processing: Used for
black-and-white and other high contrast
documents. A single level is set to

determine the black-and-white transition.
The threshold is programmable over the
entire density range. Fixed Processing
sets Contrast to 0. If Fixed Processing is
selected, Contrast is not available.

Halftone: In addition to the black and
white display, Halftone can present a
somehow gray shade of image by using
different size of dots. Halftone image looks
like the picture we have seen in the
newspaper. Options include Halftone 1,
Halftone 2, Halftone 3, Halftone 4,
Halftone 5.

Error Diffusion: Error Diffusion is a type
of Halftone. Error Diffusion gives good
image texture and makes text in images
more readable than Halftone.
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Threshold

Used to convert a grayscale image to a
bi-tonal image. The value ranges from O to
255. A low threshold value produces a lighter
image, and can be wused to subdue
backgrounds and subtle, unneeded
information. A high threshold value produces
a darker image, and can be used to help pick
up faint images.

Adjust the threshold setting by dragging the
Threshold sliding bar to the left or right to
achieve the desired threshold setting.

4 ® & &

— [ —

200 dpi, 200 dpi,
Threshold:50, Threshold:100,
Brightness: O Brightness: O
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Gray

Document Type: Choice: Normal, Photo, Document
Three options of document type are provided when you choose
Gray as the image type for your scanned document. Choice:
Normal, Photo, Document.

. Document: Choose Document if your original contains
pure text or a mixture of text and graphic since it is an
optimal setting for regular business document. When
using Document, only Threshold can be adjusted.

. Photo: Choose Photo if your original contains photo to
reproduce your photo in vivid grayscale image. When
using Photo, no Threshold and Contrast can be adjusted.

o Normal: When using Normal, Threshold, Brightness, and
Contrast can be adjusted.

Threshold: The value ranges from O to 255. The default is
230. A low threshold value produces a lighter image, and can
be used to subdue backgrounds and subtle, unneeded
information. A high threshold value produces a darker image,
and can be used to help pick up faint images. Adjust the
threshold setting by dragging the Threshold sliding bar to the
left or right to achieve the desired threshold setting.
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Normal Photo Document
(Threshold: 230)

Normal Photo Document
(Threshold: 230)
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Brightness  Adjusts the lightness or darkness of an
image. The higher the value, the brighter
the image. Drag the slider to the right or
left to increase or decrease the brightness.
The range is from —100 to +100.

Contrast Adjusts the range between the darkest and
the lightest shades in the image. The
higher the contrast, the bigger the different
grayscale. Drag the slider to the right or
left to increase or decrease the contrast.
The range is from —100 to +100.

Brightness: -50 Brightness: O Brightness: +50
(Normal)

Contrast: -50 Contrast: O Contrast: +50
(Normal)
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Resolution A good control of the resolution results a
good detail of an image that scans. The
resolution is measured by dots per inch
(dpi). Normally, the greater the dpi
number, the higher the resolution and the
image file size. Be aware that greater
resolution takes more time to scan, and
more disk space for the scanning image.
For your information, an A4 size color image
scanned at 300 dpi at True Color mode
consumes approximately 25 MB of disk
space. A higher resolution (usually means
over 600 dpi) is only recommended when
you need to scan a small area at True Color
mode.

Choose a resolution value from the drop
down list. The default value is 200 dpi.
Available resolutions are 75, 100, 150, 200,
300, 400 and 600. Or you may choose your
desired value by clicking the box in the right
side of the drop down list and press the
arrow key to select your desired value and
then click the Add button to include it in the
drop down list. Note: The resolution is up

to 300 dpi if an imprinter or a MICR reader is
installed or connected to the scanner.
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Resolution: 75 dpi Resolution: 150 dpi
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Invert Reverses the brightness and the colors in the
image. The default setting is Black on a White
background. Reverse mode is White on a Black
background. For color images, each pixel will be
changed into its complementary color at the
command of Invert.

“I am not worthy to have you #nter my

:that is God, I beqg all my brothers - thosew
& who work manuslly, clerics and lay brothers
ards elng humble in all things; nat to glorify
r to become interlorly proud because of good w
sametimas says or does in them or through tl
ard:  “Do not rejoice--- in the fact that the de
1 10:20} Let us be firmly convinced of the fact

Black on White

“I am not worthy to have you enter m

that is God, I beg all my brathers - those v
E who wotk manually, clerics and lay brothe

rds being humble in all things, not to glorify
to become Interlerly proud because of good
sometimes says or does in them or through Y
rd; “Do not rejoice--- in the fact that the dd
10:20) Let us be firmly convinced of the fa

White on Black
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Scan Choice:
Source + Auto Document Feeder: Used to scan
multiple pages.

- Flatbed: Used to scan a single page. For
example, pages from newspaper clipping,
paper with wrinkles or curls.

+ Flatbed (book): Used to scan several
inside pages from book.

+ Automatic: Allow the scanner
automatically set its scan source. If
Automatic is selected and there is
document in both the auto document feeder
(ADF) and the flatbed, then the scan source
will be automatically set to ADF. If
Automatic is selected and there is
document only in flatbed, then the scan
source will be set to flatbed.

+ Merge Two Sides into One Image:

If you have a sheet-fed duplex scanner with
front input tray, you can scan an A3 size
document with an innovative method.
Thus, fold your A3 size document into A4,
and then load the paper in the front tray.
Choose Merge Two Sides from the Scan
Source option and then the scanner is able
to scan both sides of your document and
merge two A4 images into one A3 image.

When you select Merge Two Sides into One
Image, the Cropping or Multi-feed function
will be disabled.

Note: This feature must be used with a
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carrier sheet. Regarding how to load a
document with a Carrier Sheet, refer to
Section 4.6.2, Other Paper Selection.

Note the options vary based on type of
scanner.

Note: If you have purchased a duplex sheet-fed
scanner, choose [Merge Two Sides] on the
[Scan Source], then the scanner is able to scan
both sides of your document and merge them
into a single image.

If “Merge Two Sides into One Image” is selected,
its choice will be available including “Merge
Horizontally”, “Merge  Vertically”, “Merge
Vertically (Back Side Flip)”. If the reverse side
of your document is upside down, choose
“Merge Vertically (Back Side Flip)” and the back
side will be automatically rotated 180 degrees
and merged.

Front
Side
...................... Front Rear
Side i Side
Rear :
Side
Merge Vertically Merge Horizontally

Note the options vary based on type of
scanner.
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Color
Matching

The purpose of Color Matching is getting the
accurate color. This option uses the default
parameters (ICC profile) to adjust the colors
of the image.

Choice: None, Document, Photo

None: Choose “None” to disable this

option.

Document: Choose “Document” if your
original contains pure text or a mixture of
text and graphic since it is an optimal
setting for regular business document.

Photo: Choose “Photo” if your original
contains photo to reproduce your photo in
vivid color image.

After Color Matching
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3.3.3 Scanning color images
The following options are available for scanning color images.

+ Brightness
« Contrast

« Resolution
- Invert

3.3.4 Scanning grayscale images
The following options are available for scanning gray images.

- Brightness
- Contrast

« Resolution
. Invert

3.3.5 Scanning B&W images
The following options are available for scanning B&W images.

« Binarization (Dynamic Threshold)
+ Resolution
- Invert

Or
- Binarization (Fix Processing)
- Threshold
« Brightness
+ Resolution
« Invert
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3.3.6  Editing Profiles

The Scanner Properties dialog box allows you to change and
save your frequently used scan settings into a profile. You can
edit these profiles by renaming or deleting them.

To add a new profile,

1.

Customize your settings. (For example, change your
resolution, image type, cropping method, scan size, or other
scan settings.)

Click the Image tab and then choose “Profiles” to prompt
the “Edit Your Profile” dialog box.

[ —r— =

ot ks i D | ez Dy Tt

ok Wi Proie: Diupié, BEEW, 200 doi « [ add Dhelete.

Click “Add” to enter the name of the profile and then choose
“Save”.

Add A New Profile

Flease enter the name of the profile:

[ Save J | Cancel

The new profile will be saved and shown in the “Profiles”
dropdown list box.
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To load a profile,

1. From the Image tab dialog box, choose your favorable
profile from the “Profiles” dropdown list box.

Edit Vour Profile =Bl )

Profile:

Add | [ Delte |

Fiename... ‘ ‘ Fesat I
Duples, Gray, 200 dpi

Simplex, Bi&, 200 dpi
Simplex, Color, 200 dpi
Simplex, Giray, 200 dpi

Exit

2. Your favorable profile will be immediately loaded and
displayed on Scanner Properties dialog box.

To delete a profile,

1. From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.

Edit Your Profile [E=H B

Profile: [Fiatbed - [ Add ] [ Delete |

[ Eename ‘ [ Fesmt I

Exit ]

2. Choose the profile you want to delete from the dropdown
list box.

3. Click “Delete”. A Confirm message “Are you sure you want
to delete this profile?” is prompted.

4. Choose “Yes” to delete or “Cancel” to quit.
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To rename a profile,

1. From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.

Edit Your Profile = ||| ]

Profile:

[ Add... | | Telste ]

Dplex, B&&W, 200 dpi [ Rensme ) | Reset ]
Iroplex, Calor, 200 dpi

Draplex, Grray, 200 dpi
Flatbed.

Simplex, BE&&W, 200 dpi
Simplex, Coloy, 200 dpi
Simples, Gray, 200 dpi

Exit |

2. Choose the profile you want to rename from the dropdown
list box and then click the Rename button.

3. Enter new name for the profile.

Rename a Profile @

Pleaze enter the new name of the profile:

Original Marne: Betsy

New Mame:

Save | Cancel |

4. Choose “Save” to save the new profile or “Cancel” to quit.

Note:

e The preset default profiles include Flatbed, Simplex-B&W,
200 dpi, Simplex-Gray, 200 dpi, Simplex-Color, 200 dpi,
Duplex-B&W, 200 dpi, Duplex-Gray, 200 dpi, Duplex-Color,
200 dpi. If you have a simplex or a sheetfed scanner, the
duplex or the flatbed option will not be available.

e If any setting for a current profile has been changed, a [*]
sign will be marked before the name of current profile, for
example, [* Duplex, Color, 200 dpi]. If desire, click the
[OK] or [Scan] button and a dialog box will be prompted to
let you save the new profile.
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3.4 The Compression Tab

The Compression tab allows you to compress your scanned
image and choose the level of compression. Bi-tonal images are
normally compressed using CCITT standard called Group 4 (G4).
Color and grayscale images are often compressed using JPEG
technology. Move the JPEG Quality slider to the right or left to
increase or decrease the level of compression. Note the greater
the compression level, the lower image quality. Default is 50%.

Note that the compression depends on your image editing
application. If your image editing application does not support
the type of compression format, then either a warning message
will appear or the image quality of the compressed file will not
be acceptable.

JPEG (Joint Photographic Editor Group). This group developed
and lent their name to a file compression standard for color and
grayscale images that is widely used by scanners, and software
applications. On Microsoft Windows-based systems, a file with
the extension .jpg has normally been compressed using this
standard.

For scanning color or gray images, the following compressions
are available:

- None

« JPEG

For scanning B&W images, the following compressions are
available:

- None

+ G4
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Qg Scanner Properties .

Image | Compression |Faper ISeﬂ.ing | Information

i —
ST R—
Er—

" FoAtoCon Do ]
S —
B —
S —

The Compression tab dialog box
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3.5 The Color Dropout Tab

3.5.1 Color Dropout Selection

The [Color Dropout] tab allows you to select either green,
red, blue, or a color of your choice to remove the details
of the selected color from a scanned image. This feature is
used to sharpen your text when using OCR (Optical
Character Recognition) software. Note this feature applies
only to the gray or black and white image.

Choice: None, Auto, Remove Red, Remove Green, Remove Blue,
Custom
- None: Does not remove any color.
- Auto: Automatically outputs the image with the details of
the primary color removed.
- Remove Red/Remove Green/Remove Blue: Outputs the
image with the details of the specified color removed.
- Custom: Specify the color you wish to remove by entering
its RGB (Red, Green, and Blue) value respectively.

Advanced Options:

- Quality Mode: Range: 0—20. Default: 10
When [Quality Mode] is selected, you can determine the
color to be dropped out using the [Filter Threshold] slider. A
lower value will drop more of the selected color out, while a
higher value will leave more of the selected color in.

- Normal Mode: Use an optimized setting to determine the
color.
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Preview the color dropout result:

To preview the color dropout result, please follow these
steps:

1.

Click the [Scanner Properties] icon () on the upper
left corner, and choose [Tab] to show available tab

names.

Choose [Preview] to show the Preview tab.

Click the [Preview] tab to show the Preview page.

Load your document to the scanner and click the
[Preview] button to get a preview image.

On the [Image] tab, click [Gray] or [Black and
White] image mode and then choose [Custom] on

the [Color Dropout] tab. A [Preview window] button

will be displayed.

Click the [Preview window] button to prompt the
[Preview] window with the previewed image.
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Move your cursor over the preview image. Your
mouse cursor now becomes an Eyedropper.

Click to select a color which you wish to remove.

Click and hold your mouse button to view the
result after removing the specified color. If the
result is satisfactory, click [OK] to close the
Preview window.

- ak i ] &
AL 129, 130.0: 118 Cancet 4,20 8162 e

The Preview Window The Color dropout result
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5 Scanner Properties

Image ICompressicn Color Dropout | Paper | Preview ISeﬁing I lnforrnaﬁor1|

| |Front Auto Cclc:'.Deted.ion
frone Lalar

B T —

[Fonpaw |

| |Rear Auto Color Detection
| |Rear Color

[ |Rear Gray

Color Dropout:

Mode:

Threshold

[None

[¥#] Advanced Processing

_.Non'nal

T

[ [RearBaW

] [ Cancel

The Color Dropout dialog box
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To select a color on the Color palette,

. 2 Scanner Properties E
1. Click the  ColOr | comm] oot Je e s vomsen
Dropout tab from | (s
¥| Adverced Processing
the Scanner [
) ) 1 Front BAW
Properties dialog
box.
(e Gy
Fear BAW.
Ocdos | T
2 Scunnes Propertis ==

2. Choose Gray Or B&W | i jcousmen o s [ras | oves | g | ismiten

from the Image ] | Cetropac

Selection box and = ]

click “Custom” from m
the Color Dropout - = =
drop-down menu. — ) -

The Color palette —
appears.
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3. Move your cursor
over the palette. The
cursor becomes a
cross sign.

s Seannes Propesties
image | Compresson | Cob Dropnst | Fager [ Presien | Seting | Iomuson

Frors Gey
¥ [t AW

[Fonee 40

Delads

Cokor Dvogpuns [Custom -
gesied Fsessng
Find. 2
[ 19 4
o =)
. | Preview Window |
o Cancel

4. Click to choose a color. The RGB values are changed

simultaneously.
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3.6 The Paper Tab

The Paper tab allows you to define values relating to image
output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-Feed
Detection).

2 Scanner Properties

| Image I Compression I Color Dropot | Paper | Preview | Setting | Irﬂnrrnatlnn|

Cropping: lMcmabc 'J
[ Cantier Sheet Mode

None

@ Portrait Landscape
0.00 8.50(=
0.00 14.00
Adjustment: Left: 000 = Top 0.00
Right: 0.00 = Bottom: 0.00 =
Background Setting: [Whﬂe Backaround vl
Unit: [\nches VI
Feeding
Transport Timeout: 1| 7 b 0 Seconds

Lo [ caes

The Paper tab dialog box
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3.6.1 Cropping

Cropping allows you to capture a portion of the document
being scanned. Choice: Automatic, Automatic (36”),
Fixed to Transport, EOP (End of Page) Detection,
Automatic Multiple, Relative to Documents.

Options Description

Automatic Automatic adjusts the cropping window
according to different document sizes and
automatically straighten a skewed
document. Use this option for batches of
mixed-sized documents.

Automatic Automatically adjusts the cropping window
(367) according to different document sizes
smaller than 36” and automatically
straighten a skewed image. Use this option
for batches of mixed-sized document.

Note: The availability of this feature
varies due to scanner model.

Fixed to | This feature allows you to define the area
Transport or zone to be imaged. Use for batches of
same-sized documents. If you select this
option, you can use the arrow keys to
define the x and y offset values, width and
length to redefine your scanned area. The
Display window will show image placement

as you change the values.
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EOP (End of | This feature allows you to define the area
Page) or zone to be imaged. Use for batches of
Detection same-width but different length
documents. If you select this option, you
can use the arrow keys to define the x and
y offset values, width and length to
redefine your scanned area. The Display
window will show image placement as you
change the values.
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Automatic This option allows you to place various
Multiple sized documents such as photos, ID Cards,
or business cards on the flatbed (if
available) and lets you create multiple
individually cropped images in one scan.
Note: To correctly create multiple images,
please make sure there is at least 12mm
(0.5™) of space between each document.

Relative to | This option allows you to crop different
Document areas on your documents and deliver these
images in B&W, Gray, or Color separately.
For example, there are applications which
require you to store the entire document in
B&W and a part of the document in color to
save storage space. This is useful for
documents where a photograph or
signature appears in a consistent area on
the document such as resumes, and so on.

The following options are only available when Fixed to
Transport is selected.

. X-Offset — the distance from the left end of the scanner
to the left edge of the scanning area.

+ Y-Offset — the position from the top end of the document
to the top end of the scanning area.

«  Width — the width of the scanning area.
. Length — the length of the scanning area.

+  Center: automatically calculates the x-offset for center-fed
feeding based upon document size selected.

o

. — relocate the scan area by click the arrow key on the
cross sign while retain the scan size. View the result from
the Display window.
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The Adjustment option is available when Automatic is
selected.

+ Adjustment —adds a positive/negative margin value
Top/Bottom or toward left/right of the image. Adjustment
is used when the automatic document feeder is used.
Adjustment reduces the possibility of corner clipping on
skewed images. To set Adjustment values, use the UP/Down
buttons to select where you want to apply Adjustment
values: Top/Bottom or Left/Right, and then select the
amount of inches/mm/pixels applied. Select a value within
the range of 0.00 to 1.00 / -1.00.
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Relative to Document: (used for batches of same-sized
documents)

This option allows you to crop different areas on your documents
and deliver these images in B&W, Gray, or Color separately.
For example, there are applications which require you to store
the entire document in B&W and a part of the document in color
to save storage space. This is useful for documents where a
photograph or signature appears in a consistent area on the
document such as resumes, and so on.

The following procedure describes how to reproduce the entire
document in B&W and a portion of document (picture) in color.

1. On the Paper tab, choose “Relative to Document” or “Fixed
to Transport” from the Cropping option.

2. Choose your scan size from the Scan Area option. The
selected scan size will be displayed in a red rectangular box.
This is also the scan size of your entire document. (For
example, ISO B5. If you have not chosen a scan area and
leave the selection as None, then the default area will be
the scanner’s maximum.)

_ Scanner Properties =
image | Faper | Preview | Seming | informasion

Frort Auto Color Detecton 1 3 3 4 8 & 7T & #
Frort Color o sl sl laulal
Frord Gy
4] [Fromt BAW

Raar Auta Color Dietection
Rear Color
Res Gy
Rear BAW

7T Ared
rectangular
box

Scan Aea.
S B - 1825 257 mm

@ Pome

KOMaet 0g7

Drefauds Prosasw [+ 3 Cancel
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3.

The Image —
Selection

4.

Click the Preview tab to display the Preview window. A
black rectangular box appears to indicate the max. scan
size your have just selected.

[T Scarnar Frapartes 5]

Box

: : — A black
= )| a2 rectangular
some @ box

Click the Preview button to view the entire image in low
resolution to correctly crop your relative scan area.

| o Samner Brepesten ==

[y [om— ey sy [ — e — p—

— The Preview
Image

- The Preview
Button

Select image type from the Image Selection box. The
selected image will appear in highlighted color. (For
example, Front Color)

Place your cursor on the Preview window and click your left
mouse button. A cross sign will appear as illustrated.
Create your relative scan size diagonally by dragging the
left mouse button to your preferable size. The selected
area will appear in a red box as illustrated.
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image | Compresson | Coior Drmpout | Faper | Preves | Seng | infomaton
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Relative
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:
i
!
i

Check the B&W image from the Image Selection box to scan
the entire document.

Click the Scan button to start scanning the document in two
image types and sizes. (See the result in below.)

i cogregaionspttogther S ey e b "ot Dramnadrochit e
mmm el i dead,” b sighed. “The yo

e,
you don’t bave o look for an ot
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i et sl Dt Scotish unves Nor Ut berman's dnughr
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sene deparments, hee i il research sihed ogehe te s of ber per

Seottand. 3

The entire document in B&W The relative area in color
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3.6.2 Other Paper Selection

Carrier Sheet Mode:

Check this option to automatically crop the scan window
according to your document size when scanning non-standard
document (fragile, irregular-size document) with a carrier sheet
(optional). Note: The availability of this option varies due to
scanner model.

Loading Documents Using a Carrier Sheet

A Carrier Sheet is a plastic sheet specifically used for loading
non-standard document onto the scanner. It allows you to scan
document that can not be scanned in the regular way. Also,
documents larger than A4 size, such as A3 and B4, can be
scanned by folding in half, inserting into the Carrier Sheet, and
scanning in duplex mode. You can also scan documents that can
be damaged quite easily such as photographs, or irregular size
documents that are difficult to load directly such as clippings.

To scan document using a Carrier Sheet,

For documents larger than A4/Letter size, such as A3

a. Fold the sheet to be scanned in half.
b. Fold the sheet tightly and smooth out crease. Otherwise, the
sheet may be skewed during scanning.

I

LU

I
I
I
I
I
I
I
I
I
I
!
I

1. Open the Carrier Sheet and place the document
inside.
Align the top of the document to the top of the Carrier
Sheet (the printed area).
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For documents larger than A4/letter size, such as A3
Align the top of the document to the top of the Carrier
Sheet (the printed section) and the folded portion to the
right edge of the Carrier Sheet so that the document fits
into the Carrier Sheet at the upper corner.

For non-standard document
Center your document in the Carrier Sheet.

2. Load the Carrier Sheet with the gray section (printed
section) facing downwards.

3. Adjust the paper guides to the width of the Carrier Sheet.
Adjust the paper guides so that there is no space between
the guides and the Carrier sheet. Space between the
guides and Carrier Sheet may cause the Carrier Sheet to
become unaligned during scanning, and skew the scanned
image.

4, Start the scan.
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Notice:

e [Carrier Sheet] is available for the models that support the
Carrier Sheet.

e Some functions are disabled when [Carrier Sheet] is
checked.

e This option may not work properly on some applications.

Scan Area

Choose your desired paper size with the drop-down list box. Or
you may select a custom paper size by clicking the Scan Area
box and then click Add to include in the choice.

Choices are listed below:

None
US Letter- 8.57x 11~

US Legal — 8.5” x 14~
ISO A4 — 21 x29.7 cm
ISO A5 —14.8 x 21 cm
ISO A6 — 10.5 x 14.8cm
ISO A7 — 7.4 x 10/5 cm
ISOB5 —-17.6 x 25 cm
ISOB6 —12.5x 17.6 cm
ISOB7 —-8.8x12.5cm
JISB5 —18.2 x 25.7 cm
JISB6 —12.8 x18.2 cm
JISB7 —9.1 x12.8 cm
Scanner Maximum
Long Page (<118”)
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Long Page (<118”):

When you need to scan documents whose length exceeds
scanner maximum, please choose Long Page. Note if Long
Page is selected, the Multi-Feed Detection will not be
available. (Note: This option and the maximum allowable
document length vary due to type of scanner.)

When Long Page (<118”) is selected, be sure to specify your
document size in the Length and Width field.

Notice when scanning long page document:

1. Pull out the extension in the ADF Paper Tray.

2. Secure enough space around the Output Tray to prevent the
ejected paper from falling off the Output Tray.

3. To ensure the performance, in color mode, set the
resolution to be 300 dpi or lower; in Black and White mode,
set the resolution to be 600 dpi or lower.

4. Depending on your system environments, application, or
your specified paper size, there may be insufficient memory
to perform scanning.

OverScan

Overscan allows you to add a specific margin at top and bottom
or right and left (Options vary based on the type of scanner) of
the edge of the image. This is used to reduce possible corner
clipping on the skewed images and often applied to a batch of
skewed document to be scanned in the auto document feeder.
Select a value between 0 and +5 mm. Note the overscan
result will not be shown in the Display window and that the
availability of the function varies based on type of scanner.
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Pre-Feed

Choice: Enable, Disable. If enable is selected, you can set the
amount of time the scanner starts pre-feeding your paper after
your documents has been loaded into the feeder. The default is
disable. Note: The availability of this option varies due to
scanner model.

Transport Timeout

Set the amount of time the scanner will wait and then start auto
scan after the first scan job is completed. If you have many
separate documents need to be scanned at the same scan
settings, this feature is especially useful. The default is 0. The
value ranges from O to 30 seconds.

Note:

1 Within the specified timeout period, if you load your
document to the feeder, the scanner starts scanning
automatically.

2 If your scanner has a flatbed option and you place your
paper on the flatbed, after the timeout period, you need
to click the Scan button on the TWAIN user interface to
start scanning.
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Background This option allows you to set your scan
Setting background. Choice: White Background,
Black Background.

Note: For a sheet-fed scanner with an auto
document feeder, this option is currently
available only in the “Auto crop” mode. For a
scanner with a flatbed platen, this option is
available either in the “Auto crop” or the
“Fixed to Transport” mode.

3 ¥
White Background

S
Black Background
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3.7 The Multi-Feed Detection Tab

Multi-Feed Detection

Multi-Feed Detection allows you to detect overlapped document
that go through the auto document feeder. Multi-Feed usually
occurs due to stapled documents, adhesives on documents, or
electro-statically charged document. Note : The availability of

the function varies based on type of scanner.

‘4 Scanner Properties
[Image | Paper | Mui-Feed Detection | Preview | Setting | Information |

Mutti-Feed Detection
[ Additional Length Detection: Hone =

[T Utrasonic: Detection

after Multi-Feed

&
o

Unit: Inches -

Defauls oK
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Additional Length Detection

Additional Length Detection allows you to define the length of
document being multi-fed. This value indicates the additional
length exceeding your scan area. The Display window will show
the size of the document as you change the value. A value of O
indicates no additional length detection. The Additional Length
Detection is best used when scanning same-size documents in
the auto document feeder.

Ultrasonic Detection

Ultrasonic Detection allows you to set overlapped document by
detecting paper thickness between documents. Note: The

availability of the function varies based on type of scanner.

There are two options available if Multi-Feed is detected.

e Stop Scanning after Multi-Feed

B If this is selected, the scanner will stop the feeder and
prompt a multi-feed warning message. In addition, the
multi-feed paper will be ejected from the scanner
automatically.

Note: The availability of the [Auto Clear Multi-Feed
Paper] feature varies based on scanner type. If your
scanner does not support this feature, remove the
multi-feed paper manually.

[ ] If this is not selected, the scanner will continue
scanning the entire document though multi-feed is
detected. After the entire document has been scanned,
a multi-feed dialog box will be prompted to indicate the
page number which has been detected multi-feed and
need to be rescanned.
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1. Multi-Feed Alarm

If a wave file is added, the scanner will make a sound alarm
if multi-feed is detected yet no Warning dialog box will be
displayed.

How to add the sound alarm :

1. Click the Browse button on the right side of the speaker icon.
The Open dialog box appears.

Choose your wave file.
3. Click the Open button. The wave file is added.

Units

Defines the primary measurement system. Inches,
Millimeters, and Pixels are available.
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3.8 The Preview Tab

The Preview tab allows you to preview (a low-resolution scan)
your image before final scan. This preview image lets you
allocate your scan area. You can choose your scan area by the
“Scan Area” drop down list box or placing your cursor on the
Display window and dragging it diagonally on the Display window.
Then, a red rectangle box will appear to indicate the selected

area.

Note: If you choose “Automatic Cropping” on the “Paper Tab”,
then to select a scan area on the Preview tab is not allowed.

L\mage i Compression iCo\ar Drgpomerarper | Preview [Satinrgri Info;mﬁ'

=
[ [Rear Auto Color Detection |
] [RearColr |
Bl — g

Scan Area: 7
[150 A4 - 2102 287 mm - 5

—n
@
-

S

—

Eo
w

Lol b Lol

bW w

@) Portrait Landscape 9

HOffset: 012
Y-Offset: 0.00

Wiidth 827
Length 1169 =

Unit Inches -

[7] Selected area applies to all modss

Defaults Preview |[ oK 1[ Cancel ]

> Scanner Properties [3e)

The Preview Tab

The Display
Window
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3.9 The Enhancement Tab

The Enhancement tab allows you to set following additional
image processing settings.

- Scanmer Properties

| Image | Paper I Mutti-Feed Detection | Prewewl Enhancement iSemng | Infnrmatmn!

Punch Hole Removal

Punch Hole Removal

Background Setting

None
1 b
Vhite

Edge Fill

@ White |71 Edge Extend
/ Black 0 Milimeters
Despeckle Line Removal
Noise Radius: 1 =] Piels 100| Milimstes

The Option tab dialog box
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Punch
Hole
Removal

You can remove punch holes from the output
scanned image when scanning punched document.
Note the availability of this feature varies
depending on your scanner model.

Original Output

Punch holes can not be removed when:

e Resolution is set lower than 150dpi

e The hole is near the edge of the document

e The holes are not aligned along the edge of the
document

e Punch Hole Removal is available only when
“Auto Crop” is enabled. If either “Fixed to
Transport”, “EOP (End of Page) Detection”,
“Automatic Multiple”, “Relative to Documents” is
selected from the Cropping option on the Paper
tab, the Punch Hole Removal option will be
disabled.
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Shadow Removal

When "Flatbed ;on the "Scan Source |
option is selected on the "Image | tab,
the "Shadow Removal ; option will be
enabled. Click to remove the shadow on
the book spine when scanning a book.

| L ot 2

Before Shadow
Removal

After Shadow Removal
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Background Processing: The [Background Processing]
option allows you to smooth background color or remove it to
make image clearer. The option is especially useful for
documents with color forms such as invoices.

Choices: None (default), Smooth, Removal

- None - no background processing will be performed (default)

- Smooth - produces images with a more uniform background
color. This option improves image quality.

- Removal - identifies the background color and then removes
it.

Sensitivity: Choice: 0, 1, 2, 3, 4. Default: O
- The higher the value, the more background color will be
kept.

Mode: Auto, Moiré
If [Smooth] is selected in the [Background Processing]
option, then the choices for the [Mode] option includes Auto,

and Moiré.

- Auto - uses the factory preprogrammed mode to proceed
background smoothing.

- Moiré — Remove the moiré patterns that appear on the
background of the image when scanning printed material.

If [Removal] is selected in the [Background Processing]
option, then the [Mode] option will be replaced with [Fill Color].

Choices: White, Auto.

- White - identifies the background color and substitutes it
with white.

- Auto - identifies the background color and substitutes it with
the color of the largest background zone.
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Edge Check White or Black if you wish to add white or
Fill black edge on the border of your scanned image.
Enter the value from O to 5 mm. Default value is 0.

Original Edge Fill: 5mm (Black)
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Despeckle

Occasionally small dots or specks appear in the background of a
scanned image. Remove unwanted speckles provides a cleaner
image for OCR (Optical Character Recognition) processing, and
also helps to reduce compressed file size.

Define the speckles (also known as image noise) you wish to
remove by specifying its number (size) and radius (range). The
measuring unit is pixel. The higher the number, the more
speckles will be removed.

l“;%plague on thee! Hast thou
never an eye in thy head? Canst
not hear? .
—The First Part of King Henry the Fourth:
2.1.26-27

A carrier to Gadshill, the host of a tavern.

Before Despeckle
(noise number:0, noise radius:1)

%plague on thee! Hast thou
never an eye in thy head? Canst
not hear?
—The First Part of King Henry the Fourth:
2.1.26-27

A carrier to Gadshill, the host of a tavern.

After Despeckle
(noise number:22, noise radius:10)

Note:

. The function is currently available for Black and White
image only.

. To scan at rated speed, it is recommended to set the noise

radius up to 10 pixels.
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Line Removal: When Black and White image mode is selected
on the [Image] tab, the [Line Removal] option will be enabled.
Line Removal erases lines on the image and then reconstructs

characters so the OCR (Optical Character Recognition) accuracy
can be improved.

Choices: None, Form, Horizontal, Vertical
None — the default mode which does not remove any line.
Form — remove any form in the document.

Horizontal — select [Horizontal] and then enter the length of
horizontal line to remove only the horizontal line exceeding your
specified length.

Vertical — select [Vertical] and then enter the length of vertical

line to remove only the vertical line exceeding your specified
length.
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3.10 The Rotation Tab

The Rotation tab allows you to set the following image rotating
options:

_;3 Scanner Properties

| image | Paper | Muti-Feed Detection | Freview | Rotation | Enhancement | Setting | Information

Rotation

Rotation Degrees : [None v] {ode: Quick

Image Control Options

Split Image: [ None = I

Flip Side Rotation

@) Book Farfald

Image Control Options
[ Mimor

o (s
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Rotate Choose the rotation angle from the drop down
Image list if you wish to rotate your scanned image.
Choice: None, 90°CW(clockwise),

90°CCW(counter clockwise), 180°, Auto
based on contents. Auto rotate every

even page.
[E—
123 -
(e
Original Rotate 90°CW
N
= €T 1
—
Rotate 90°CCW Rotate 180°

Auto based on contents: Automatically
rotate images based on the contents of
document. When " Auto based on contents |
is selected, its modes will be enabled to let
you select more options.

Mode: Quick, Full Text, Complexity

Quick — the default mode to let you rotate
images at the fastest speed.

Full Text — the enhanced mode for
documents with mixed text orientation.

Complexity — the enhanced mode yet at the
slowest speed for document with complex
image or text orientation.
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Auto rotate every even page:
Automatically rotate 180° on every even
page. This is especially useful when you scan
the inside pages from a book. As a result, if
you choose “Flatbed (book)” from the “Scan
Source” option, “auto rotate every even page”
will be selected as default.

Note: This option varies based on type
of scanner.

g g e W |
.: e Daantas. vy La sasie =

Document with various | Document with dark or
text orientations complex background
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Split
Image

By splitting an image, two separate images are
created horizontally or vertically. This is useful
for documents containing two pages per image
when you want to save them as two images
(one page for one image). Choice: None,
Horizontal, Vertical. Default is None.

Horizontal: Divide one image into the upper
half and the lower half.

Vertical: Divide one image into the left half and

the right half.
i
e

Split Horizontally Split Vertical
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Flip Side Select “fanfold” to rotate the image of the
Rotation reverse side to 180 degrees.

This is applied to double-sided document
which are viewed in portrait are sometime
fed into the scanner in landscape or vice
versa.

Choice: Book, Fanfold.

If “Book” is selected, the image of the
reverse side will not be rotated.

The following illustration shows the documents which should be
viewed in portrait are fed into the scanner in landscape
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Image  Check the Mirror box if you wish to reverse the right
Control and left side of your image.
Option

]

b
The Mirror Effect
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3.11 The Separation Tab

The Separation tab allows you to enable the detection engine to
detect the blank page, barcode, and patch code and then notify
the software application which supports document separation to
separate your multi-page documents. Choices: Blank Page
Removal, Barcode Detection, Patch Code Detection.

2 Scanner Properties (=]
| Image | Paper | Muli-Feed Detection | Preview | Rotation | Separation | Enhancement | Setting | Information|

Blank Page Removal

] Blank Page Removal Threshold:

Barcode Detection

| Enable
Patch code Detection
[ Enable
Defauls il Cancel

Blank Page Choices: None, Blank Page Removal Threshold,
Image Size.

None — Do not remove the blank pages.
Threshold - Move the slider to the left or right
to define your threshold for the blank page.

Image Size — Range: 1~ 10000 KB. Specify
your desired image size to detect the page as a

Removal

blank page. For example, if 3 KB is selected,
any page less than 3 KB will be recognized as
blank page.
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Barcode Check [Enable] to detect barcode and notify

Detection the software application for advanced
processing. Please note the whole document
will be checked and no specific detection area
needs to be designated.

When the bar code has been detected successfully, a file
[avbarcode.ini] will be created and stored in the following path:

Windows XP: C:\Documents and Settings\All Users\Application
Data\%PRODUCTNAME%6

Vista, Windows 7, Windows 8, Windows 10:
C:\ProgrambData\%PRODUCTNAME%

Barcode Types:
The following barcode types can be detected.

Two-dimensional codes

e Aztec

e DataMatrix
e PDF417

e QR Code

One-dimensional barcodes:
Add-2

Add-5

Airline 2 of 5

Australian Post 4-State Code
BCD Matrix

Codabar

Code 128 (A,B,C)

Code 2 of 5

Code 32

Code 39

Code 39 Extended

Code 93
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Code 93 Extended
Datalogic 2 of 5

EAN 128 (GS1, UCC)
EAN-13

EAN-8

GS1 DataBar
Industrial 2 of 5
Intelligent Mail (One Code)
Interleaved 2 of 5
Inverted 2 of 5
ITF-14 / SCC-14
Matrix 2 of 5

Patch Codes

PostNet

Royal Mail (RM4SCC)
UCC 128

UPC-A

UPC-E

Barcode Zone:
Specify the barcode zone to be detected.

Select [All] to checks the whole document and detects barcodes.
Or you may speed up the process by specifying a detection area
since only the specified area is checked.

Choice: All, Top, Bottom, Left, Right, Bottom Right,
Bottom Left, Top Right, Top Left
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Choice for barcode zone on a page:

All

Top

Bottom

Left

Right
Bottom Bottom Top Right | Top Left
Right Left
Note:

° Recommended resolution: 200—~600 dpi for regular barcode,
300~600 dpi for QR code

e Skewed barcodes may not be recognized correctly.

° Using the same sheet repeatedly may decrease the
recognition accuracy due to accumulated dirt on the sheets.
If the sheet is not recognized correctly or gets smudged,
replace it with a new sheet.

Patch code Detection:

Check [Enable] to detect patch codes and notify the software
application for advanced processing.

A patch code is a pattern of parallel, alternating black bars and
spaces (i.e. a barcode) that is printed on a document. Patch
code sheet is most commonly used as a document separator in a
stack of document.
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You can find various sizes of patch codes (PDF) by choosing
[Start] menu=>[All Programs]>[Avision Scanner
Series]>[Patch code] in succession.

Simply print the PDF file to produce the patch code sheet. Insert
the patch code sheets to wherever you want the file to separate.

Patch code
sheet

Notes to print the patch codes:
° Use blank white paper.

e  Set the scaling to 100%. The sheet is not recognized
correctly when printed in a size smaller than the original.

° Do not use toner saving mode. The sheet is not recognized
correctly when the print is too light.

° Do not use thin paper in order to avoid bleed-through from
the back.

e When you copy a patch code sheet that you printed out,
make sure to copy by the same size and brightness as the
original copy.

° Use the same sheet repeatedly may decrease the
recognition accuracy due to accumulated dirt on the sheets.
If the sheet is not recognized correctly or gets smudged,
replace it with a new sheet.
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3.12 The Setting Tab

The Setting tab allows you to set the following settings:

2 Scanner Properties ==
| image | Paper | Setting | information |

Cache

Mode: Memory Size =

Memory Size: ‘ b Defaut

Energy Saving Control

Enable Energy Saver b 15minses

-

Felzd (V] Enzble Power OF ' Z40mintes

[¥] Show Scanning Progress Tabs:
|1 Compression

V] gV

7] Show Warming Message | Colr g
1 Muli-Feed Detection
; 1 Preview

[ 7] Eisct Paper Opposts |5 Rt
01 Separation
01 Enhancement
D imprnter

Defauls 0K Cancel

The Setting tab dialog box

Energy Saving
Control

Check the Enable Energy Saver box
and move the slider to set the amount
of time to start the energy saver after
your last action. The range is from 1 to
240 minutes. The default value is 15
minutes.

Enable Power

Off

Check the Enable Power Off box and
move the slider to set the amount of
time to automatically turn off the
scanner after your last action. The
range is from 1 to 480 minutes. The
default is 240 minutes (4 hours). Note
the value of “Power Off” has to be
greater than or equal to the value of
“Energy Saving”.
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Cache Mode: None, Page Number, Memory
Size.

This option allows you to assign a specified
memory size from the available RAM to
process the image data. By specifying a
smaller memory size, you can free more
memory for other applications you are
running. By specifying a larger memory
size, you can have more memory to
process the image data especially when you
have a large amount of documents needed
to be scanned.

You can also specify your memory size by
the page number. For your information, an
A4 color document scanning at 300 dpi
consumes approximates 24MB.

Image Count

When the selected cache mode is “none”,
the image count option allows you to assign
number of pages you need to scan. For
example, if you wish to scan the first two
pages, simply move the page slider to 2,
and the scan action will be stopped when
the scanning of the first two pages have
been completed.
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Show Scanning | Check and the scanning progress bar
Progress will be shown during scanning.

Show Warning | Check to show the warning messages
Message such as “ADF pad count exceeds
50,000 scans (the number varies based
on type of scanner). Please replace the
ADF pad and reset the pad count.”

Save Settings | Check to save your scanner properties
after Closing settings after leaving the dialog box.
Next time when you open the Scanner
Properties dialog box, the previously
saved settings will be shown.
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3.13 The Imprinter Tab

The Imprinter tab allows you to print alphanumeric characters,
date, time, document count and custom message on your
scanned image if digital imprinter is selected or at the back of
your document if external imprinter is selected.

‘2 Scanner Properties (3m)

[image | Paper | Setting | monnter | information |

"] Digital Imprirter

Advanced Print Position

Sample

ooo

Defaults Ok Cancel

Choice: External Imprinter, Digital Imprinter. If you have
installed an external imprinter, choose external imprinter. If you
do not have an imprinter, choose digital imprinter. Note External
Imprinter provides a vertical and rear-side print capability while
digital printer provides a horizontal and front-side print
capability.
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Contents

Print All Check Print All to automatically print the
text at all pages of your documents.
Uncheck Print All to print the text for the
first page of your documents only.

Custom Enter your custom text to be included in your
print string.

Counter Show the document count for the scan

session. This value is increased sequentially
by the scanner.

Date/Time | Choose if you wish to include the date and
time in your print string.

Format: YYYYMMDDHHSS For example,
20090402170645-check0001 indicates year,
month, date, hour, seconds, your custom
text and the counter.

Custom Choose your desired font.

Font Choice: Normal, Fixed Width

Fixed Width (Mono spaced) fonts have a
fixed character spacing. So each character
occupies the same width.

Advanced

Font Choose your font attributes. Choice:
Attributes Normal, Underline, Double, and Bold.
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String Choose your string orientation.

Orientation | Choice: Normal, Rotated, Vertical,
Vertical Inversion, 90 degrees CW, 90
degrees CCW

2qeQLoc
2010abc

Normal Rotated

oo ®mOoO—=ON
NO—O@ao

Vertical
Vertical Inversion

2qeQL0e
2010abc

90 degrees CW

90 degrees CCW

If you check the digital imprinter to stamp
text on your scanned image, the illustration of
normal and rotated string is shown below:

2010abc 9QqE0lOC

Rotated

Normal
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Print Choose the position you wish to print your
Position string. Move the slider to the right to increase
the value or to the left to decrease the value.
Range: 0—355mm, default:0 mm

The value indicates the height from the
bottom of your paper to the last letter of your
string. This option is available only if an
external imprinter is installed.

| The value of
Print Position

4‘—>0TOZ 9gqeT000

Print Position (for digital imprinter)

Choose the position of your printed string. Choice: Top, Middle,
Bottom, Custom. If Custom is selected, enter the X and Y
offset value to specify the position.
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3.14 The Information Tab

The Information tab displays the following system and scanner
information.

“z+ Scanner Properties )

image: | Paper | Setting | Imprinter | Information

Info

CPU: intel{r) Core(TM)13-2120 CPU @ 3.30GHz Iz

RAM: 1023 MB

05 Microsoft Windows 7 Enterprise Service Pack 1 (Buid 7601)

05 Language English (United States)

Disk Drive: Foced drive C:\Total:30717MBFres:10439MB
Foced drive Y:\Total:102398MBFree: 1054 TMB -
Foced drive Z:\Total: 102398MBFree:2331TMB 7

Free Disk Space 10439 MB

Application Name Avision Capture Tool 1.6 (1.9)

TWAIN Driver Version 6.11.032916

140 Driver Varsion: 0.9, 2016, 324

Port Type: usB

1D / Address usB

Optical Resoltion: 600 dpi

Scanner Model. FB10O

Senial Numbsr NO25 -

| Repott...

Cancel

The Information tab dialog box

The “Report” button:

If you encounter any error message while using the scanner,
click the Report button. A report.txt file [Windows XP:
C:\Documents and Settings\All Users\Application
Data\%PRODUCTNAME%; Vista, Windows 7, Windows 8,
Windows 10: C:\ProgramData\%PRODUCTNAME% (C: system
drive)] will be generated. Please send this file to the nearest
service center for trouble shooting.
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4. Maintaining Your Scanner

4.1 Cleaning the Glass
The Cleaning Procedures

1. Moisture a piece of soft cloth with some isopropyl alcohol.
(95%)

2. Open the document cover as shown below.

Gently wipe the document glass.

4. Close the document cover. Your scanner is now ready for

w

use.
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4.2 Frequently Asked Questions

Question:

Answer:

Question:

Answer:

The scanned image always comes
out to be too dark.

1) Please adjust the screen settings to
sRGB.

2) Please adjust the brightness
settings on the screen from
application software.

When | choose resolution to be
600 dpi, the “auto crop” and
“deskew” functions will be
disabled.

Since to perform auto crop and deskew
consumes great deal of system
memory, it is suggested if you wish to
perform “auto crop” and “deskew”
functions, please choose your optical
resolution to be smaller than 600 dpi
to prevent a error message.
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4.3 Technical Service

Before contacting Avision, please prepare the following
information by referring to Section 3.14, The Information
Tab:

®  Scanner serial & revision number (located on the bottom of
the scanner);

= Hardware configuration (e.g., your host CPU type, RAM size,
free disk space, display card, interface card);
The name and version of your scanning software application;
The version of your scanner driver.

Please call us at:

Headquarter

Avision Inc.

No. 20, Creation Road I, Science-Based Industrial Park,
Hsinchu 300, Taiwan, ROC

TEL: +886 (3) 578-2388

FAX: +886 (3) 577-7017

E-MAIL: service@avision.com.tw

Web Site: http://www.avision.com.tw

US and Canada Area

Avision Brasil Ltda.

Avenida Jabaquara, 2958 - Cj. 75 - Miranddpolis —
CEP: 04046-500 - Sao Paulo, Brasil

TEL: +55-11-2925-5025

E-MAIL: suporte@avision.com.br

Web Site: http://www.avision.com.br
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China Area
Hongcai Technology Limited

7A,N0.1010,kaixuan Road,Shanghai 200052 P.R.C.

TEL :+86-21-62816680

FAX :+86-21-62818856

E-MAIL : sales@avision.net.cn

Web Site: http://www.avision.com.cn

Europe Area

Avision Europe GmbH

Bischofstr. 101 D-47809 Krefeld Germany
TEL: +49-2151-56981-40

FAX: +49-2151-56981-42

E-MAIL: info@avision-europe.com
Web Site: http://www.avision.de

Espaco Brasil

Avision Brasil Ltda.

Avenida Jabaquara, 2958 - Cj. 75 - Miranddpolis —
CEP: 04046-500 - Sao Paulo, Brasil

TEL: +55-11-2925-5025

E-MAIL: suporte@avision.com.br

Web Site: http://www.avision.com.br
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5. Specifications

All specifications are subject to change without notice. For the
most up-to-date and detailed specifications, please refer to our
web site at http://www.avision.com

Model Number :

Technology:
Light Source :

Optical Resolution :

Max. Scanning Size:
Scanning Mode :

Interface :
USB Bus Power :

Operating Environment:

Temperature :
Humidity :
Dimension (WxDxH) :

Weight :

BF-1606B

Contact Image Sensor (CIS)
LED (Light-Emitting-Diode lamp)
1200 dpi

216 x 297 mm (8.5 x 11.7 in.)
Black & White

Gray
Color
USB 2.0

5Vdc, 500mA

10°C — 35°C
10 —~ 85% RH

255 x 355 x 46 mm
(11.04 x 13.98 x 1.81 in.)

1.4 kg (3.1lb.)
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